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Basic 1.

Creating a document

Creating a Web page begins with
the creation of a new document.
First, give the document a name.
Next, add headings and type in
the text.



Start TopPage:

'Welcome to TopPage

1. Start TopPage, displaying the TopPage 2. Click Edit Without Using the Site.
main window and the Welcome to Check that Create a Blank Page is
TopPage dialog box. selected, and click the OK button to open
a new page.

Specily a document title:

54 TopPage - [newpagel_htm - Untitled] Attribute E4
Document Properties
GardeningShop

—

1. Select Document Properties from the 2. Type "GardeningShop" in the "Document
Edit menu to display the Attribute dialog Title:" field.
box.



Specify the image for the background:

Attribute x| Attribute x|
oot Coor| Metalnio] Dthers|
L
I
[z
Text
Link.
Wisited Link,
I | Ative Link
[ ol | RessiE|
[ oc ] coeel | v |
1. Click the Background/Text Color tab. 2. Click the Browse button for the
background image to display the Open
dialog box.

Attribute x|

Document Properties
A new.qgif

: z:::gz:; ’7 file:#¢/C: /Program Files/IBM NetObjects TopPage/tut I

A plant3.gif

T
i

3. Click the Open button.Select the bg file 4. Click the OK button to change the
stored in the images folder. background.
Click the OK button. (The images folder
is in the tutorial folder.)



Specily a heading:

+54 TopPage - [newpag

Eile Edit “iew Fc

e =S8

. [
5
I_ Headihg 2 —
Heading 3
r Heading 4 Docur

1. Select Heading 1 from the Paragraph
box.

Add a horizontal rule:

lable Frame Site Tool ‘Window Help

Table Frame Site Tool “indow Help
SIS E RN N
I[EEEB I U &L & | &

|
R
[x

s

e
[*

ardening Shop

—

2. Type "Gardening Shop" in the heading-
type paragraph.

e |G B 12 2 R (e 2

—|HEH| B I UA L&

rdening Shop

1. Move the cursor under the heading.

2. Click the Horizontal Rule icon.



Enter text:

Table Frame Site Tool Window Help

EEEEE R e L

=E HEHE B IU AL

1

rdening Shop

about living with a house plant 7
g8 your room a nice atmosphere |

1. Enter text as in the example.
If you want to make a line break, press

Enter key.

Save:

t2t TopPage - [newpagel.

File Edit ‘iew Fomat

N ||| & =

INDrmaI %j

=== {-—--
——— -—-
- T——-

1. Click the Save icon to display the Save

As dialog box.

Save As 2] x]

Save jr: | ‘3 IBM NetObjects TopPage j gl H

@ Desktop
5 My Documents
tdy Computer
=4 3% Flappy (4]
;
[ ] ram Files
3 IBM NetObjects TopPage
D]
]

Fil Metwork Neighborhood _—

TSRS iy My Brisfrase
Ornline Servi

L

i

2. Select the drive where you want to save
the document from the Save in box




Save As 2| x| Save As

Save_in: j EYI\U_ = Save_in:lEl ] j il
&)

ty Documents f=y ty Documents

Program Files 1 Program Files
“indows 1 windows

File name: Inewpage1 “htm Save I File name: |newpage1 _htm Open I

Save as lype: IHTMLfiIes = il bt~ shtml”. shitm) j Cancel |/ Save as ype: IHTMLfiIes [~ hitrnl;_ kb= shtml;™ shitrn) j Cancel |/
i i
3. Click the new folder icon. 4. Type "Gardening" for the folder name.
Save As 2] x| Save As 2] x|
Savein | = [C) = Savein | ] Gardening =l =1
My Documents
Program Files
Wwindows
File name:  [newpage.htm Open File name: indes hin Save
Save a3 lype: IHTML[“ES [ bt bt shiml:*. shitrm) j Cancel |/ Save as lype: IHTMLfiIes [# bkl kb shtrnl ;. shibm) j Cancel |/
i i

5. Select the "Gardening" folder, and click

6. Type "index.htm" for the file name.
the Open button.

Click the Save button to save the
document to a file.



C:\Gardening'

7. Click the OK button to save.






Basic 2.

Using a table for layout

Let’s enhance your Web page by
creating a table, pasting images,

and changing the table settings.



Create a table:

L
ol Window Help
e e ) — H|E 1| =

2B 1 us x| EEa e

lening Shop

tliving with a house plant 7
i room a nice atmosphere.

1. Click the Insert Table icon to display the
Insert Table dialog box.

Paste images:

- Frinters

=8 Contral Panel

- Dial-Up Metworking

71 Sebediuled Tazks LI
[&n Files (=% =l
Link ] Fie __Contens |

|Gardélﬁ5g8h0p

[ [T

1. Click the Contents tab.

10

Inzert Table

| ) M
] 1

Columns:

Cancel
Bows: 3

Help

J,
it

2. Type "2"in the Columns box and "3" in
the Rows box.Click the OK button.

|Site iz ot open. 2=
[ Sits Folder = 2] A
-] bin 2]
. =] gallery
l #-_] guide
w2 msese
! =] zample J
{:I template
=8 {:I bukorial
..... a
l {:l oy
-] loopyt
&-{771 Intermet Fenlarer LI

2. Using the Contents pane, Select the
images folder in the tutorial folder.




1 TopPage - [index. htm - GardeningShop *] 1 TopPage - [index. htm - GardeningShop *]

P ul HE e
o || @al=aea s

plart] gif

3. Drag and drop one of the images into the 4. Repeat step 3 to paste images into all the
upper left cell of the table. cells on the left, as shown in the example.

Edit the images:

1 TopPage - [index. htm - GardeningShop *]

plart] gif

1. Select the image in the lower left cell. 2. Click the Edit Image icon to display the
Edit Image dialog box.

11



, Edit Image

w Edit Image |

3. Click the Rotate button twice to rotate the 4. Click the OK button.
image clockwise 180 degrees. On the dialog box that prompts you to
Click the Rotate button again. overwrite, click the Yes button.

Enter text:

tuit TopPage - [index.

Tl

EHEEEIEHHEI 3
Heading 4

R R =

1. Select the upper right cell. 2. Select Heading 3 from the Paragraph
box.

12



abiout living with a house plant 7o
¥es your toom a nice atmosphere.

1 Syngonium I

w

. Type the foliage plant name as shown in
the example.

cabout living with a house plant 74
VES YOuL toom a nice atmosphere.

Syngonium

[ |
$16.50 eachd
ships: May 15,99 thru Sep 01,99]

5. Enter a comment for the foliage plant as
shown in the example.

bout living with 2 house plant 74
¥ES VOU toom anice atmosphere.

Move the cursor under the heading.

Syngonium

$16.50 eachd
ships: May 15,99 thra Sep 01,99

Codiaeum

$15.00 eachd
ships: June 10,99 thra Sep 15,99

Doracaena

"
$17.50 eachd
ships: May 15,99 thra Sep 01,99

Repeat steps 2 through 5 to enter the
foliage plant names and comments in all
the cells on the right, as shown in the
example.

13



Change the table settings:

1. Select the upper right cell and click the 2. Click the table tab.
Attributes icon. Set the following items:
Table Width: 400 pixels
Cell Spacing: 5 pixels
Border: Off

3. Click the cell tab. 4. Click the Others button to display the
Click the colored button next to Select Color dialog box.
Background.

14



Color

_Ilﬁlll_l_l_l
N [ [\
IS =
il b i
...

R T

5. Select a color, then click the OK button. 6. Set the following items:
Cell Width: 250 pixels
Apply to the Entire Column: On
Click the OK button.

Save:

txt TopPage - [index.htm -
plant1. gif C:\Gardening'

= plant2. gif C:\Gardening'
::: I plant31.gif C:\Gardening’,

1. Click the Save icon. 2. Click the OK button to save.
The Save Files dialog box is displayed.
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Basic 3.

Setting a link

This section explains how to set a

link to another file.



Create a subpage:

ey

454 TopPage - [index.htm -

1. Click the New icon to create a new file.

Attiibute x|

GarderingShop

|
I
—

[ ok ] _twod | e |

3. Type "GardeningShop".

18

% TopPage - [newpage2_htm - Untitled]

2. Select Document Properties fromthe
Edit menu to display the Attribute dialog
box.

Attiibute x|

Document Properties

Text
Link
Wisited Link
Active Link

4. Click the Background/Text Color tab.
Click the Browse button for the
background image.



Open EE
Loak jn: Iaimages j il

4 leaf.qif
AT new.gif
o plant].gif
4 plant2.gif
A plant3.gif

File: hame: Ibg_g\l Dpen 800 » 200

V' Preview
=l Cancel

Files of tupe: IImags files

5. The Open dialog box is displayed.
Select the bg file in the images folder,
and click the Open button.

t5t TopPage - [newp

File Edit “iew

NE=HE S|

|_§ MHarmal
Heading 1
Heading 2

Heading 4

7. Select Header 3 from the Paragraph box.

Attribute

Tag IDucumenl Propeities j

Document Info  Background/Text Colar IMEIaInfUI Dlhelsl

Background Imag
’VIFiIE'N.r‘E /Program Files/IBM NetObjects TopPage/tut

Page Color

Background: Q”m Reset1]
Test: ll [Nomall || Reseti2]
it | [remal | [Resei
isited Link: ll [Nomal] | Reset[d)
AtiveLink: [T <[ [Memal | Resei®

Apply
0K -, Cancel | Help

6. Click the OK button to change the
background.

8. Type "Syngonium".

19



9. Paste the image from the Contents
pane.

onium

" » How to Laok After - Mo derately bright environment but wit

11.Enter comments as shown in the
example, and press Enter key.

20

10.Click the Insert Bulleted List icon.

" » How to Lok After - Moderately bright encvironment but withou
e Skill Level -- Fasy
e Tips - Try giving the plant a moderately bright environment|

12.Repeat step 11 and enter comments as
shown in the example.



Save As
2 TopPage - [newpageZ. @l e
EJ '3 index. htrm

EEIN
HTML files [ html;= htrn;™ shitml;. htrn) I

13.Click the Save icon to display the Save 14.Type "sub.htm" for the file name.
As dialog box. Click the Save button to save the file
"sub.htm.”

Set a link to a subpage:

1 TopPage - sub.htm - GardeningShop

plant2 plart3gi

1. Click the Original Size button on the 2. Click index.htm to position the subpage
subpage. to the front.
You can then edit index.htm.

21



i TopPage - index.htm - GardeningShop

3. Select the foliage plant name in the upper 4. Click the Insert Link icon to display the
right cell of the table. Link dialog box.

Attribute Dpen

[Soeaws 50| @)

'3 index. htm
.= i sub bt

HTHAL filez [*.html;. htm;* shtml;* shtm]

5. Check that the To URL tab is selected. 6. Select sub and click the Open button.
Click the Browse button to display the
Open dialog box.

22



Attribute

7. Click the OK button.

t5+ TopPage - index_htm - G

Heading 3

8. Click the Save icon to save the index.htm
file.

23
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Basic 4.

Setting a site

You can create a site, which
consists of multiple Web pages that

are linked to each other.



Create a new site:

Select Dperation

e
BN
GardeningSid

1. Select Site Wizard from the Site menu. 2. Type "GardeningSite" for the site name in
the Select Operation dialog box.
Click the Next button.

Set Site Items:

N A
X = @ =
S Y- £ ] i
& ubhtm
g 5 [E
EEEEEE

[ o |
HTHAL filez [*.html;. htm;* shtml;* shtm] I

3. Click the Select button. 4. Selectindex.
Click the Open button.

26



Set Site Items

Setup Destination Server

GardeningSite

. pravider com
=

eublc_him]

5. Check that both the top page and the site 6. Set the destination server.
folder are specified. (Note: The destination server shown in
Click the Next button. the figure is an example. Ask your

provider or system administrator about
the destination server and folder.)

Dperation after Setting Completion

TopPage

A
o] e | coes |

7. Select Open the Site after Closing 8. Click the Yes button on the dialog box.
Settings. The site "GardeningSite" is set.
Click the Finish button.

27



Check the site:

i TopPage - [index. htm - GardeningShop]

= TopPage

EI@ Top Pagel/index.htm]
&-[3] subhtm

1. Check that the "GardeningSite" site is on 2. Drag and drop the index.htm file into the
the Link pane. editor to open it.

28



Basic 5.

Uploading Web pages

This section explains how to
upload Web pages to your

provider’s server.



Click the page:

=t =

1. Select Site Check from the Site menu to
display the Site Check dialog box.

Find Result

C:M\Gardeningtindes. htm
C:M\Gardening'sub. hirn

3. Check the search results, and click the
Close button.

30

Site Check

2.

ﬂk I

Check that "GardeningSite" is selected as
the target site and select the Alternate
Text check box.

Click the Start button to begin the check
and display the search result.



Upload the web pages:

¢ Tool “Window Help

4 1|22 52 (%0 R
I E PR U

1. Click either the Site Upload or the Page
Upload icon, depending on your
requirement.
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Advanced 1.
Using WebArt Designer

WebArt Designer is a tool for
creating logos and buttons. This
section explains how to create an
original logo for your Web page
title.



Start WebArt Designer:

1. Select WebArt Designer from the Tool
menu.

Create a button:

Button Wizard (Shape)

1. Click the Button Wizard icon. 2. Select a shape for the button.Click the
Next button.

34



Button Wizard [Caolor)

Plain Colar

3. Select a color.Click the Finish button. 4. Adjust the size of the button.

Create a logo:

Logo Wizard (Text and Font)

1. Click the Logo Wizard button. 2. Type "GardeningShop".

35



Logo Wizard [Text and Font) Logo Wizard [Color)

Plain Ciolor

3. Set the following items: 4. Select a color.
Font Name: Times New Roman Click the Next button.
Size: 32
Style:
Bold: On

Anti-alias: On
Alignment: Left
Click the Next button.

Loge Wizard (Qutline) Loge Wizard (Logo Effect)

5. Click the Next button. 6. Select Shadow from the logo effects.
Adjust the strength and distance.
Click the Finish button.

36



|@*@||_|_|2%-ﬁ|mmg|

ardenmﬂShop
3

7. Adjust the logo position.

Paste an image:

JNG o,

irmeert rrirrar

| o

Lage IButtu:unI Framel Bau:khgn:.uundl Other

|Fput test, then drag and drop a template of logdto o

1. Click the Other tab.

x|
* Sample M aterialz j ﬁﬂ ;I
=] zample ;I
{:l imange
- 1 java
..... D soript
{:l zound J
----- ] webart
-] template
=~ {:l tutorial
..... %
I o,
1-I771 lennnt LI

2. Select the images folder.

37



Carileniat e

3. Paste an image with a drag-and-drop 4. Drag the logo layer to make it the top
operation. layer.

Adjust the brightness of the image:

ebArt Designer

GardeningShop

1. Select the button object. 2. Select Rasterize from the Object menu.

38



Comrect the Brightness and Contrast x|

===t
="

3. Click the Brightness/Contrast icon. 4. Adjust the brightness.

Correct the Brightness and Contrast E3

S=e

| —

-

| e e | |

5. Click the OK button.

39



Combine the images:

ebArt Designer

|

» |

ardenmgshop

1. Press and hold Shift key and click all the 2. Select Combine from the Object menu.
images.

Paste the combined image into the Web page you
are editing:

Bao ke [FeEEBoH|A0EEu

noShiop
)

1. Paste the combined image with a drag-
and-drop operation into the TopPage
editor.

40



Advanced 2.
Using Style Sheets

A style sheet enables you to create
more graphical Web pages. This

section explains how to set a style.



Define the style:

ger x|
e
_ et sl

Show current style status

e Site Tool Window —

=& 3=

Iﬁlﬂ

Add Edit Delete

Add External Style Shest

1. Click the Style icon to display the Style 2. Click the Add button and select Create
Definition dialog box. and Add The Style.

x| K
AT WALIAERR | HTML tag n document s abe o have the stles, The eRiAR ALAEE] 1ML tag n dacument s able o have the stk The
e e style il be applieci o the whole doctmert e e style wil ke applied t the whole document
HIML TagList HTML Tag List:
HIML Tag Name: == HITML Tag Mame: <
007 [Eurert Element BODY = T [Heading 1 H1 =l
Cuntem Element BODY -
Fort | Color and Backaraund | Font | Color and Background | Test layout | Layet | List | Postion|] Others |
Prioritized Font List Document Properties BODY Prioritized Fant List: Available Font List:
Parsgraph P =
Fieading 1 [l Gl o
i 5
:eag‘”g g :g Courer New
oading
B
Heading 4 H4 Comic Sans M5 |
Sies :::J:S : :: = Size: Font &tibute:
S lkep] dcress ADDRESS Elkeword 2] [# weinht -
Block Hucle BLOCKQUOTE nomal
Decoraion: [ none Cetion posy Decoration:  [none S
[Junderine | Befining Instance: DFN [Junder fne bolder
Meverine | Guotation a [ over ne = bt
arp Cortents of No-seript Mode NOSCRIPT aml 100 hind
Style Container (Block] DIV 200
paBbyyza |Svie Conlaner (nine]  SPAN AaBbYyZz 300
Textto Be Typed KBD w0 400 hormal) =
Progiam Code CoDE os
Prefomalted PRE -
Sample Output SAMP J 0K | Caed | Hep |
hie SIP &2

3. Check that Set the style to the HTML 4. Select Times New Roman from the
tag is selected and select Level 1 Available Font List box.

Heading Elements from the HTML Tag Click the left-arrow button.
List box.
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ot e HTML tag in document is able (o have the styles. The e eI HTML tag in document is able (o have the styles. The
Setthe sl fothe D style will be applied (o the whole document. Setihe sl tothe D style will be applied (o the whole document.
TR HTML TagLit TR HTML TagList
Aag Name: ag Name:

T IHeadmgT H1 =l CEEE—— IHeadmgT H1 =l
Fort | Color and Background | Test layout | Layout | List | Postion| Others | Fort | Color and Background | Test layout | Layout | List | Postion| Others |
Priorized Forn List Available Font List Priorized Forn List Available Font List
Times New Foman o | [Times Hew Roman Times New Foman o | [Times Hew Roman

el el

Couier Hew Couier Hew

Size

Comic: Sans M5

Comic: Sans M5

Font &tribute: Size: Font &tribute:
[6a o =] [@ weigt = [ea Hloet = 300 v thick] =
nomial ® s
Decoratior:  TInane - @ bold Decoratior:  TInane omal
[under ine " bolder [under ine
over line | lighter over line | previ
2l 100 thin]

\aBbYyZ |

400 [narmal) =l

ok | Concel | hen |

® vaiant J
T nomal
o | smalicaps
1aBbYyZ. a

® bansform

ok | Concel | hen |

5. Set the font size to 60 pixels.

Select the weight - bold check box in
Font Attribute.

6. Select the style - italic check box in Font
Attribute.

5| ]

HTML tag in document is able to have the siyles. The
style will be applid 1o the uhole documert.

HTML TagList

—_—
Shaw the shyle Bzt
Show current style status

HTML T ag Name: Help
o [ Heading 1 HI = =
Style List{curent document]
Font  Color and Backgiound | Teut layeut | Layout | List | Postion| Qthers|

¢ [HT [Headng 1]

Color noimal =l

noimal
E————uger defined

Backgiound Color
~Background Image —|

e by

| | Browse

huchsia Add Edit Delete
—— — r and &dd T
Horizantat

,— rs—— Eg eat Add External Style Sheet
— raron eat (horizontaly) ¥ Forr

cat (verticaly) b Color
tepeat

e E— purple —ment

ey ol

= ilves Ed

—

Vertical ™

ok | Concel | hen |

7. Click the Color and Background tab.
Select green from the Color box.
Click the OK button.

8. Click the Add button and select Create
and Add The Style.

43



E[ e shle to the E‘“ HTML tag in document is able to have the styles. The
Settre sole 0 thelD sty will be 2pplied 1o the whole document.
HTML Tag List
HTML Tag Name:
Ca— | Currert Eloment BODY =l
Cunen! Element BODY -
Fort | Color and Bakground |
Pricrtized Eont List Document Froperizs ~ BODY
Paragiaph
Heading 1 H1
Heading 2 H2
Heading 3 H3
Heading 4 Hi
. Heading 5 HS —
= Heading & HE
= [kepfcress ADDRESS
Block Quote BLOCKAUOTE
Decoration:  [Jnene Citation CITE
[Junderine 1 efining Instance DFN
I Jover Ine Quatation Q
ampl Conlents of No-scipt Mods  NOSCRIPT
St Container (Block) DV
AaBbYyzz |Stie Coniainer (nine]  SPAN
Textto Be Typed KBD
Program Code CODE
Prefomatied PRE r
Sample Output SAMP J
hie SIP &2

9. Select Level 3 Heading Elements from
the HTML Tag List box.

+ M anager

o the stle st
Show current style status
Help

Style Ligtcumrent document)
<» H1[Headng1]

¢ [H3[ Headng 3 ]

Add Edit Delete

Explanation I Froperty |
1
b Fort

11.Click the X button in the Current Style
dialog box.

44

Style Del

x|
: 2 HTML lac
St the sy (o (he Class = H‘T‘MLE‘aE in dui:udmten‘lh\s alﬂe‘lu dhava thatsty\es The
Settre sole (0 heD style wil be appiied to the whole documen
HTML Tag Lisk

HTML Tag Name:

Fs | Heading 3 H3 =l
Font | Color and Baskground | Test layout | Layout | List | Postion| Others |
Prioilized Fon! List Avaiable Fant List

Times New Roman o | [Times New Roman
il B
Courier New
=)
Cormic Sans M3 =l
Size Font Attibute
EHkepod 7] - 900 [very thick] =]
* sl
Decoration:  [TInone - nommal
[ Junder ine: i@ e
[ Jover line =l obiine
ampl ® variant
nomal
AaBb¥yZzr small caps
# tansfomn =
Cancal Help

10.Set the following items for Level 3
Heading Elements, as you have done for
Level 1 Heading Elements in steps 4
through 9:

Font:
Font: Times New Roman
Font Size: 24 pixels
Font Attribute
- weight - bold: On
- style - italic: On
Color and Background:
Color: Green
Click the OK button.



Preview:

i TopPage - [index. htm - GardeningShop]

o [ = 2
Bl

L1 sanple

L3 template

&2 wtorial
] images

o DS movies : about living with a house plant 7

{1 Intsmet Explorer o wes your room a nice atmosphere
L] Microsoft MetShow
Ofice

Syng oninin
/41 Files ()

o

$16.50 each
ships: May 15,99 thru Sep 01,99

e gif plant1.gf Codiaenmn

$15.00 each
ships: June 10,93 thry Sep 15.39

1. Click the Preview tab and check that the
style is set the way you want.
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Advanced 3.

Creating an animated

Web page

TopPage supports dynamic HTML,
which enables you to create

animated Web pages.



Create a layout frame:

e =
P P

1. Click the Insert Layout Frame icon to
display the Layout Frame dialog box.

Paste the image:

® ‘p

rew, gif plant . gif

¥ B8

1. Click the Contents tab.

48

2. Click the OK button.

I:I template
E||:| tutarial
iz
tl o
i leopyt
f-_1 Internet Explarer
f- ] Microsoft MetShow
i Microsoft Office
I:Ll M athd pisbinn

2. Select the images folder in the Contents
pane.



3. Paste an image within the layout frame
with a drag-and-drop operation.

Set the effect:

1. Select the layout frame and click the 2. Set the following items.
Attributes icon to display the Layout Position (left): 300 pixels
Frame dialog box. Position (Top): 150 pixels

Size-Width: 50 pixels
Size-Height: 40 pixels

49



Layout Frame

From left

3. Click the Effect tab. Set the following items:
Effect : Wipe (Appear)
Pattern: From left
Speed: High
Click the OK button.

Preview:

21 TopPage - [index.htm - GardeningShop *]

about living with a house plant ?

e yortoim ke i

Syngonis

$16.50 each

ships: May 15,99 thru Sep 01,99

Codinenm

$15.00 each
shios: June 10.99 thry Sep 15.99

1. Click the Preview tab and check that the
effect is set the way you want.
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Advanced 4.

Using Web Animator

Web Animator is a tool for creating
animated GIFs automatically.
This section explains how to create

an original animated GIF.



Start Web Animator:

Wb fAnimator

1. Select Web Animator from the Tool
menu.

Add Animation Effect:

1. Click the New button. 2. Click the Insert Image icon.
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Insert image

3 Gardening

=
Al Image Files

i

3. Select plantl in Gardening folder. 4. Repeat step 3 and 4 to insert plant2
Click the Open button. image.

Change Properties at One Time

5. Select Change Properties icon. 6. Change Disposal Method to "Restore to
Previous State".
Click the OK button.
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Making Transition

7. Click the Add Animation Effects icon.

5. Web Animater - Untitled

9. Transition images are generated.

54

8. Set the following items:

Effect: Blend

Time: 2 sec

Number of Frames: 8
Click the Start Preview button to see
preview of image transition.
Click the OK button.



Save an image:

@ 'Web Animater - Un

File Edit “iew Play

0 & BN S

1. Click the Save icon to display the Save
As dialog box.

Save As 2] %]

B =@l = 5

planta1 gif

File name: |anim_gi|1 Save [: I
Cancel

Save as tpe: IEIF Files [* aif] j

2. Type "anim.gif" for the file name.
Click the Save button to save the mage to
a file.

Paste the animated image into the Web page you

are editing:
N

]I

1. Drag the Drag Drop button and drop it
into the TopPage editor.

55



56






P/N: CTENJINA
© Copyright IBM Corp. 1999
All rights reserved

Printed in the U.S.A.

To find answers to frequently asked
questions and other information, please visit
our TopPage Web site at
http://www.jp.ibm.com/esbu/E/toppage/



